HIPE Owner's Guide

1. Preface

Thisdocument givesyou ageneral overview of HIPE (Herschel Interactive Processing Environment),
the main interface to the Herschel Data Processing (DP) software. HIPE provides agraphical interface
plus command-line accessto the data processing capabilities of the Herschel Common Science System
(HCSS).

Read thisdocument if you want to obtain afirst understanding of how HIPE looksand itsfunctionality.

Tip
@ If you areinterested in more advanced features, including scripting and batch processing,
please have alook at the Scripting and Data Mining guide.

1.1. When things go wrong

In the unfortunate event of a HIPE crash, or a freeze that forces you to kill the application, please
submit a Helpdesk ticket so that developers can look into the problem.

In some cases, adump fileis created, listing the values of crucial parameterswhen the crash happened.
Please include it in your ticket, since it will greatly help developers in diagnosing what went wrong.
Hereis how to look for the dump file:

» Sometimes HIPE crashes because the underlying Java Virtual Machine has crashed. In this case,
the VM produces adump filecalled hs_err _pi d*. | og, where* isthe process identification
number. This dump fileis created in the working directory, that is, the directory HIPE was started
from. If you are not sure, please use the search function of your operating system.

* When you kill HIPE manually, a dump file called hi pe_dunp_yyyynmdd_hhmss. t xt ,
whereyyyynmdd_hhmss isthe date and time of creation.

Depending on how you kill HIPE, the dump file may or may not be created. The following table shows
the various cases and the location of the home directory for each supported operating system. Dump
filesarecreatedina. hcss/ apps/ hi pe/ dunps folder within your home directory.

Table 1. Where and when HIPE createsa dump file

Operating system Dump file created Dump filenot created |Homedirectory loca-

ager —» Applications

Manager — Processes

tion
Linux/Unix Ctrl+C or kill kill -9 / hone/ user nane
Mac OS Ctrl+C, kill or Force |kill -9 / User s/ user name
Quit
Windows taskkill or Task Man- |taskkill /f or Task C.\ Docunents and

Settings\user-
nane (Windows XP),
C.\ Users\user-
nanme (Windows Vista)

2. Getting to know HIPE

HIPE (Herschel Interactive Processing Environment) provides an integrated suite of graphical inter-
faces that can interact with each other. It alows for interactively choosing your active data in your
session, visualizing that data in various ways and selecting tools that can operate on the data. Both
command-line and GUI interfaces are available. High-level interactions, which can involve GUIs, are
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also echoed as commands on the command-line that allow the saving of commands used in a session
and the generation of scripts from these interactions.

This section provides an overview of the fundamental elements of HIPE.

2.1. Installation and startup of HIPE

Warning
o Before installing HIPE, please make sure that your default file compression program can
unzip FITS files without corrupting them. Otherwise calibration files shipped with HIPE
may be corrupted during installation. For more information see the Data Analysis Guide:
Section 1.4.6.2.

In case of any other problems during installation please check the Known Issues page or
contact the Herschel Helpdesk viathe Herschel Science Centre website.

HIPE ispart of the Herschel Data Processing system. Y ou can download an installer from the Herschel
Science Centre on this page. Installation instructions are provided at the bottom of the page.

Development builds are avail able via the Continuous I ntegration system. These builds are meant only
for Herschel software developers. If you are not a software devel oper, but you still want to get access
to these developer's builds for any particular reason, please contact the Herschel Helpdesk.

HIPE needs the Java SE Runtime Environment version 6. We recommend to install the latest update
for best performance. To see which Java version is installed on your machine type the following in
aterminal window:

java --version

Y ou can run HIPE on a server or individual workstation under one of these operating systems, either
32-bit or 64-hit:

¢ Windows XP and Vista.

e Any Linux distribution compliant with the Linux Standard Base version 3.0 or higher. A list of
compliant distributions is available on this page. HIPE may work on non-compliant distributions
too, but thisis not guaranteed.

e Mac OS X 10.5 Leopard.

HIPE is a'so known to run under Snow Leopard and Windows 7, but is not yet officially supported
on these platforms.

The minimum amount of memory needed is two GBytes. Four GBytes are the highly recommended
minimum for data processing; more may be needed in some cases (e.g. large PACS maps).

The maximum amount of memory available to HIPE can be set by choosing the Advanced install ation.
To change the available memory afterwards, modify the propertiesj ava. vm nenory. mi n and
java.vm nenory. max inthei nst al | ed. properti es filewithin your HIPE installation di-
rectory, as shown below:

j ava. vm menory. m n=64m
java.vm nmenory. max=512m

The Advanced installation also alows you to specify the name and location of a Versant database.
Only advanced users and calibration scientists should need to specify a database: if you are unsure
about this option, you probably do not need it.

For viewing the HIPE Help System, you can use any modern browser, such as Firefox, Chrome, Safari,
Opera, Internet Explorer and so on.



http://herschel.be/twiki/bin/view/Public/HipeKnownIssues
http://herschel.esac.esa.int/esupport/
http://herschel.esac.esa.int/HIPE_download.shtml
http://herschel.esac.esa.int/esupport
http://www.linuxfoundation.org/en/LSB_Distribution_Status
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Y ou can start HIPE viaitsicon or from the command line;
hi pe
Theinstaller will tell you where the hi pe executable islocated.
Note
@ Under Mac, starting from the command line only worksif you installed a devel oper build

viathe Continuous Integration System. If you used the Install Anywhere installer instead,
you have to start the application viaitsicon.

When starting HIPE under Windows, you might see two command prompt windows called hi pe and
i a_hi pe. exe appear aongside the HIPE main window. Both can be safely closed once HIPE has
started.

Upgrading and uninstalling

To uninstall HIPE, either follow the usual uninstallation procedure for your operating system, or ex-
ecute the uninstall_hipe command in the uni nst al | _hi pe directory, located in the HIPE instal-
lation directory.

It is possible to install different HIPE versions alongside each other. However, the safest way to up-
grade to anew version of HIPE isto uninstall the existing version first.

Important

A Most files of a HIPE installation are stored into a . hcss. d folder within your home
folder. Thisfolder is shared among all the HIPE installations on a computer, which means
that the uninstaller will not clean it up to avoid damaging other installations. You can
remove this folder manually after you have removed HIPE completely from your system.
Any HIPE installations left will stop working after removing this folder.

2.2. Mouse clicks in HIPE

The following table shows how left, middle and right mouse clicks are simulated on different plat-
forms.

Table 2. Mouseclicksin HIPE

Mouse click Windows Linux with two-|Mac with two-|Mac with one
button mouse button mouse button mouse

Left click Left click Left click Left click Click

Middle click Ctrl + left click Ctrl + left click Alt + left click Alt + click

Right click Right click Right click Ctrl + left click Ctrl + click

Three-button mice work as expected on all supported operating systems. The Mac five-button mouse
can be configured viathe Mouse utility in the Mac System Preference Pane as a standard three-button
mouse.

Different HIPE tools may associate different actions to the same mouse gesture. For details please
refer to the documentation of each tool in the Data Analysis Guide.

2.3. Obtaining help in HIPE

Y ou can open the HIPE Help System via the Help menu. Help pages will open in a new tab of your
default web browser. Note that the help contents are installed on your computer, so you do not need
to be connected to the Internet.



http://herschel.esac.esa.int/hcss/install.php
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Figure 1. Accessing the HIPE Help System.
Y ou can access the following help pages from the Help menu:

» Help Contents: opensthe main help window. Thetable of contentson theleft displaystheavailable
documentation, with more advanced material appearing towards the bottom (see Figure 2).

» Workingin HIPE: opens Chapter 1 of the Hipe Owner's Guide, the same you are reading now.

* Release Notes: opens the What's New document, which contains the latest additions and changes
to the system.
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Figure 2. The HIPE Help System home page.

2.3.1. The HIPE Help System

As shown in Figure 2, the HIPE Help System window contains three components:

» A pane on the left-hand side, containing the Table of Contents (TOC), the search facility and the
list of bookmarks (see Figure 3).

A toolbar at the top of the screen.

» Themain screen areawhere the documents appear. When you start the Help System, thisarea shows
aseries of links to the main manuals.
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Figure 3. Thetabs of the left-hand pane of the HIPE Help System.

The table of contents

Manuals are grouped into categories and represented by a folder icon next to a plus sign. Click on
the plus sign to view the contents of a manual. Y ou can do the same with manual sections containing
subsections. Click on any entry to display the corresponding page.

Searching the help system

Click the Search tab to display the search pane (see Figure 4).

Tz Search  Faworites

(2 J
L1 ‘

Figure 4. The search pane of the HIPE Help System.

Enter your search keywordsand press Enter, or click on the magnifying lensicon, to perform a search.
Hover your mouse pointer on the question mark icon to display a tooltip with the advanced search
syntax, also described below:

Boolean operators. her schel AND (archive OR store);archive NOT store;
+ar chi ve - store. The boolean operator words must be upper case. When writing multiple
search keywords, the default operator is AND.

Wildcards: t e?t ; maxi nt . A question mark replaces a single character, an asterisk replaces from
zero to any number of characters.

Boosting aterm: her schel ~4 ar chi ve. The boosted term is considered more relevant, which
influences the ordering of results. The default boost level is one.

Proximity searches: the string "her schel archi ve"~10 searches for her schel and
ar chi ve within ten words from each other.

Fuzzy search: her schel ~; her schel ~0. 6. Findswordswith similar spelling. Y ou can specify
afuzzinesslevel between zero and one (the default is 0.5). Lower values of the fuzziness parameter
mean that greater spelling variations are considered.

Limit search to one manual: manual : hi peowner AND her schel ; (manual : hi peowner
OR nmnual : fag) AND herschel . See Table 3 for alist of identification strings for the
manuals. Some strings (like howt os for the Data Analysis Guide) do not resemble the name of
the manual for historical reasons.

Table 3. Identification strings for manuals

Manual Id string Manual Id string
Read Me First readnmefirst SPIRE User'sReference|spi re_urm
Manua
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Manual Id string Manual Id string
Quick Start Guide qui ckstart HIFI User's Manua hifi_um
HIPE Owner's Guide |hi peowner HIFI Pipeline Specifica- | hi fi _pi pel i ne
tion
Frequently Asked Ques-|f aq PACS Data Reduction|pacs_drg
tions Guide
What's New wnew PACS Advanced User's|pacs_um
Manua
Data AnalysisGuide |howt os SPIRE User'sManual [spire_um
Scripting and DataMin- {um SPIRE Data User's|spire_dum
ing Manua
Product Definitions|pdd HCSS Developer's Ref-|hcss_drm
Document erence Manual
HCSS User's Referencelhcss_urm HIFI Developer'sRefer-|hi fi _drm
Manua ence Manual
HIFI User's Referencelhi fi _urm PACS Developer's Ref-|pacs_drm
Manua erence Manual
HIFI Expert'sReference|i cc_hi fi _urm SPIRE Developer'sRef-|spi re_drm
Manual erence Manual
PACS User's Reference|pacs_ur m
Manual
Note
@ When you use the search feature for the first time, HIPE must build the search index. This
can take up to a few minutes, depending on the speed of your system and on the amount
of installed documentation. A progress bar tells you how close HIPE isto completing the
operation.
After the index has been built, subsequent searches should take a negligible time.
The toolbar

Figure 5 shows the toolbar at the top of the HIPE help window.

Previous page Nextpage Bookmark page

l About Yajahs
i P 3 S JlﬁnI@O/
Home page
Open PDF
Synchronise TOC

Up one level

Figure 5. Thetoolbar of the HIPE Help System.

Please note the following points:

» The Previous page and Next page icons lead to the previous and next page in the manual you are
viewing. They let you move through a manual, not through your browsing history. For that, please

use the Back and Forward buttons of your browser.

» The Bookmark page icon adds the current page to the list of favouritesin the HIPE Help System,
not to your browser's favourites.
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» The Synchronise TOC icon will show the current page in the Table of Contents pane, for example
by expanding the nodes leading to it.

* Yajahs is the engine that powers the HIPE Help System. The name stands for Yet Another JAva
Help System.

2.3.2. Command line help on tasks
There are two ways to obtain help from the command line in the Console view of HIPE.
1. The help command opens the help page corresponding to a given task, class or topic:
» hel p() opensthe main Help page.
» hel p(t askNane) opens the task help page in the User's Reference Manual. For example:
hel p(i mageAdd) . Notethat not al tasks and classes have adedicated help page: if no pageis
found, you get an error message. All thetaskslisted inthe Task view of HIPE (see Section 3.3.17)
have help pages.
* hel p("plot") orhel p("pl ot xy") opensthe Plot chapter in the Data Analysis Guide.

e hel p("di spl ay") opensthe Datadisplay chapter in the Data Analysis Guide.

For more information see the User's Reference Manual : Section 2.167.

2. The __doc__ attribute of atask (note that there are two underscores on each side of doc). Print
this attribute to get a short text describing how to use the task. For example:

print imageCeil.__doc__

2.3.3. Obtaining help outside HIPE

When you quit HIPE, links in any help pages will not work anymore. Even if you restart HIPE, you
will have to open the Help System again.

To access help outside HIPE you can use the show_help, which resides in the same folder asthe hipe
executable. This brings up the following window:

hess.iadocumentyajahs.webapp Jherschelfiafdocument/war/yajahs.war
hcss.iadocumentyajahs.contentdir [izzo/Software/dp.core-1.2 /doc/yajahs

Controller
ID of document to be displayed | Iv}

‘7 Display | Exill‘

Figure 6. The standalone Help System.

Click the Display button to start the HIPE Help System. The other controls in this window are only
useful to developers of the Help System.

For advanced users: accessing the Javadoc

If you are comfortable with Javadoc documentation, you can accessit in the HIPE Help System home
page by clicking on APl documentation in the Devel oper Reference section at the bottom of the table
of contents. To obtain the traditional frame-based Javadoc layout, click on the FRAMES link on any
Javadoc page. To get back to the HIPE Help System layout you will have to use the Back button of
your browser (clicking on the NO FRAMES link will not work). To have both layouts available, you
may want to open the Javadoc layout in a new tab or window of your browser, by right-clicking on
the FRAMESIink.
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2.4. The HIPE Welcome screen

When you start HIPE you are greeted by a Welcome screen with six icons, which are described in the
next sections. Placing the mouse over each of the icons on the screen provides a small description in
the status bar at the bottom (see Figure 7).

0

File Edit Run Pipeline Window Help

(7) Welcome X [=8

Welcome to Herschel Interactive Processing Environment!

Hower your mouse over one of the images below for more information.

Tip: You can akways get back to this page by selecting in the menu bar: Help -» Weltome!

3 > v
P g @

Work BEench Access Data Documentation

¢

Preferences Updates External Tools

jET

Welcome

| ||| B EsEe ]

Figure 7. The Welcome per spective.

Y ou can return to the Welcome screen at any time by selecting Help — Welcome! per spective from

the menu bar or by clicking on the L icon at the top right of the HIPE window.

2.4.1. Icon: Work Bench

Clickingonthe

B

s

ﬁ icon takes you to the Work Bench perspective (for information on perspectives

in HIPE see Section 3.1). The default workbench is shown in Figure 16. Thisis the main work area
for doing data analysis. Here you can look at data values, plot spectra and images, create scripts for
batch processing and run analysis tools. The contents of the workbench can be updated with various
views available under the Window menu (see Section 3.3 on available Views).

2.4.2. lcon: Access Data

« v

The tz icon opens a window with four more icons, providing access to data held either locally
or at aremote site (for example the Herschel Science Archive). It also allows the import of FITS and
ASCII tablefiles (see Figure 8).

For more information on these features see the Data input/output chapter of the Data Analysis Guide.
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File Edit Run Pipeline Window Help

(7) Welcome x

Access to Herschel Data

The Herschel Interactive Analysis software provides a number of means to load and save data either remotely or locally

Herschel Science Archive Import FITS Files

The Herschel Science Archive FITS files may be Inaded into the
Perspective is a graphical user session directly, so both its contens
interface 1o the Herschel Archive. It and header (meta-dara) can be
provides the rmeans to guery on arcessed

meta-data and download the You can read FITS files generated
products directly into Hipe with Herschel software as well as

standard FITS files

Import ASCI Tables

Tahles of data written in text files can
ke read and imported into the
session as what is called "Table
Datasets” in Herschel terminology.

Access Data Products

The Product Access Layer (PAL)
provides the means 1o access and
store data procucts from and t a
wvariety of storage locations, be it

remotely (and cached) or locally, The exact columns and separators
The Product Browser allows 1o query that wou expect for your data can be
and retrieve data from PAL storages. specified in the task dialog for

reading the table.

Welcome

| || T e

Figure 8. HIPE Data Access initial page.

Click the arrow at the bottom to go back to the Welcome screen.

2.4.3. Icon: Documentation

Click on the @ icon to open HIPE documentation in your default Web browser. For more infor-
mation see Section 2.3.

See the Read Me First document for a brief description of al the available manuals.

2.4.4. Icon: Preferences

? \
The -i" icon allowsyou to accessthe Preferences dialogue window shown in thefollowing figure:
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Maximurm memaory. ME

[v] Show tips at startup

[C] save variables on exit

(D To be applied the next execution of HIPE

TableFlotter Ask which variables to restore
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Text Editor [ Inform about dump files
General
Appearance
Consale [ Check for updates
Fonts
Winciow
Help and Documentation
Mavigator
Blartup & Shutdown | [RBSIRTE (DEEIE | | Apply |
Import... | | Expaort. .. | | Ok | | Cancel |

Figure 9. The HIPE preferences window.

You can set preferences in the available categories and revert to the default values at any time. You
can also export/import the values of the preferences to/from an XML file.

2.4.5. Icon: Updates

&

Click onthe # icon to check if anew user release is available. If so, HIPE will give you thelink
to the web page where you can download the new release. The same feature is available by choosing

Help - Software Updates.

K

‘ Note

This feature only works with user releases. It does not work with developer builds.

2.4.6. Ilcon: External Tools

Theicon a takes you to a set of icons linking to Virtual Observatory tools, including VOSpec,
VOPIot and Aladin. Included in this listing is the Herschel Science Archive (HSA) browser, as Her-
schel components are VO-compliant. The HSA also uses a VO-like interface with HIPE. Clicking
on any of the icons launches the external VO tool. Help and assistance with these tools are provided
separately from within the tools or associated websites, except for the HSA browser interface which
is described in the Data Analysis Guide.

When you click on the icon of an externa application, it will be automatically downloaded and
launched. After thedownload you may see asecurity dial oguewindow telling you that the application's
digital signatureis missing or has an error. For the applications shown in this window you can safely
click on the Run button. Y ou can check the Alwaystrust content fromthis publisher checkbox to avoid
being prompted again.

Note

@ An external application is downloaded thefirst time you click on itsicon, and whenever a
new version becomes available. Note that the application will be downloaded even if you
have a version already installed on your hard disk.

Click the arrow at the bottom to go back to the Welcome screen.

10
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2.5. The toolbar and status bar

The HIPE toolbar is the row of icons just below the menu bar (see Figure 10). The icons on the right
are related to perspectives (see Section 3.1) and never change. The icons on the left, apart from the
first two (to create/open afile) may change or become deactivated according to which view is active.
Theactiveview hasatitletab of alighter colour (see Figure 11). Figure 10 showstheiconsthat appear
when you work on afile in the Editor view.

If you cannot find an icon in the toolbar, it is probably because the active view does not use it.

File Edit Run Pipeline Window Help

DeE & @ P98 1w Eae®s | &
[& x ﬁ[fﬁ&litorx o] a8 Tasks x % —mo)

Figure 10. The HIPE toolbar.

[ Tasks X [Tasks X

Figure 11. Active (left) and inactive (right) HIPE view.

The HIPE status bar is at the bottom of the main HIPE window and is shown in Figure 12.

Memory bar VO icon
| e v | |||« . J L \. |
[ Jvthon Interpreter | 37 182 °
» » .
Progress bar Line/column indicator Throbber

Figure 12. The HIPE statusbar.
The status bar contains the following elements, from |eft to right:

» Theprogressbar shows the state of advancement of any operation being executed. Useful for data
processing tasks that take along time.

» Theline/columnindicator shows the line and column where the cursor islocated whenever you are
working on afilein the Editor view.

» The memory bar shows the amount of memory used by HIPE. The bar goes from green to orange
and then to red as the amount of used memory increases.

» The throbber icon, a series of dots forming a circle, becomes animated whenever HIPE is busy
doing atask.

e The VO icon becomes yellow when HIPE is connected to a Virtual Observatory hub.

3. Views and perspectives

A view isawindow embedded in the main HIPE window, like the one shown in Figure 13.

A perspective is a collection of related views. Y ou can customise a perspective by adding, deleting
and moving views. To save space, you can also rearrange different views as tabs of the same window.

The following sections describe in detail the views and perspectives available in HIPE.

11
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Figure 13. A single element (view) for a HIPE per spective.

3.1. HIPE perspectives

HIPE comes with three perspectives, availablein the Window — Show Perspectives menu.

3.1.1. The Product Browser perspective

The Product Browser perspective provides away of getting and briefly viewing data from databases
and data stores, both locally and remotely stored. Thisisillustrated in Figure 14.

For more information see the Data Analysis Guide: Section 1.3.7.

File Edit Run Pipeline Window Help

5o

DeEa | m>»

] Product Browser x\ieﬁ,. Pl Slorage Manager

t@esm O

= o= Product Tree X B
Observation | Metadata | Free Metadata
Target Name {object) =
Proposal {proposaly ==
Instrurment {instrument) ==
Operational Day (odNumber) = :}%
i =
Observation Id (obsic) ==,T‘| |
=
[ == | o
X [ =
h [E]
~-- sglect storage —--- - |@ | -- empty storage -- . |q§b [] Wersions _ﬁ’ Run !
Observation Idf (obsic) \ Operational Day (odMurmber) \ Observation start date (statDate) | AQT ID 59 variables X —
® -
| v
& console x (=0]
HIPE=
4
[ | | | 00 of 455 ME .

Figure 14. Product Browser perspective. This providesaccessto data storesboth on-lineand on your com-
puter.

3.1.2. The Herschel Science Archive perspective

The Her schel Science Ar chive perspective provides a convenient means of querying and obtaining
data from the Herschel Science Archive (HSA). For more information see the Data Analysis Guide.

12
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Figure 15. Herschel Science Archive per spective.

3.1.3. The Work Bench perspective

The Work Bench perspective provides eight views for working with tasks, variables, scripts and
command-line inputs. You can also navigate in your file system and check log messages and the
command history. Note that the History, Log and Console are arranged as tabs (see Figure 16).

File Edit Run Pipeline Window Help
e H& =5 » Ead®m &
I Navigator x %, [ _p || ] Editer x [— o[ 8 Tasks = %, =
o F K= Al
v B3 i @ Applicable
;&User areas @ By Category
# {i Home Folder
(+- ™ File system
22 variabl.. X P
® -
Log El Console x = 5= Outline x -0
HIPE= Mo outline inforrmation a
reailable
1 »
[ | | | E of 455 ME .

Figure 16. HIPE default view of the work bench per spective.

3.2. Changing HIPE Perspectives

Y ou can modify a perspective by deleting and adding views, and by moving, resizing and rearranging
existing views. The following actions are available:

» Closing, minimising and maximising views. Each view has the usual icons for closing (next to
the view title), minimising and maximising (in the small tab on the right-hand side). Minimised
windows appear at the bottom of the workspace (see Figure 17).

13
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[+ Editor & x][E Histary, Log, Console & x}

Figure 17. Minimised views at the bottom of the HI PE window.
» Resizing views. Click and drag the borders of aview.
» Customising tabs. If you right click on the title of a view, a context menu appears. With the Tab

Orientation and Tab Direction submenus you can change the position and orientation of title tabs.
Experiment with the various options until you find what works best for you.

sl Navigat 1] Editor X %

2 Undock

— Minirmize
X Close
* Close Others
Mowe to Window Bar b

Tah Direction » Right
* [Down
4 Left

Figure 18. Customising tabsin a HI PE view.

* Moving views. To move a view within the main HIPE window, click on the view title and drag
it around. A black outline box shows where the view will be placed when you release the mouse
button.

» Undocking views. Undocking aview means turning it into an independent window, separate from
the main HIPE window. To undock a view, click on its title and drag it away. A small rectangle
under the mouse pointer (see Figure 19), with no black outline anywhere in the HIPE window,
means that the view will be undocked when you release the mouse button. To dock an undocked
view, right-click on itstitle and choose Dock from the context menu.

indow Help

l B M Mawigator

15 | I= Navigator X [

' Edito

Figure 19. A view being undocked.

* Moving through tabs. If awindow istoo narrow to display al its tabs, three new controls appear:
two arrows to cycle through the tabs, and one more arrow to get the list of tabs (see Figure 20).
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kages | = Navig 4 » ] Editor X
[J] Classes

[ Packages

Figure 20. Moving through tabs.

Adding views. To add aview to a perspective, select it from the Window — Show View menu. If
aview isaready in aperspective, it will not be added again.

* Resetting a per spective. Any change you make to a perspective will be kept in future HIPE ses-

sions. Torestore aperspectivetoitsoriginal settings, choose Window — Reset perspective, or click
the arrow icon on the toolbar, next to the perspectives icons (see Figure 21). You can aso right-
click on theicon of the modified perspective and choose Reset per spective from the context menu.

Figure 21. Theicon to reset a per spective.

3.3. HIPE views
3.3.1. Classes

Thisview lists al the classes (routines) available in the session. These can include scripts you loaded
into the system. To obtain help on an item, right-click on it and choose Help in URM. This opens the
corresponding entry of the User Reference Manual in your web browser. If there is no information
available in the URM, the menu entry does not appear.

3.3.2. Console

The Console view provides a command-line interface to all HIPE commands and functions.

Press the Up key to access previous commands. This feature also works across sessions: if you have
just started HIPE, pressing the Up key will show the last command of the previous session.

Most graphical toolswithin HIPE echo in the Consol e view the commands corresponding to the action
being taken. Thisisuseful if you want to automate a certain procedure through a script.

For more information on the scripting language used by HIPE, see Scripting and Data Mining.

3.3.3. Editor

Usethe Editor view to display and edit scripts and other files. When you open a Jython script, a set of
editing commands becomes available under the Edit menu (see Figure 22) and asiconsin the toolbar
below. Hover your mouse over each icon to obtain atooltip.

You can customise the Editor window for Jython scripts and other text files by choosing Edit —
Preferences. This opens the main HIPE Preferences window. Set the options under Editors & Viewers

- Jython Editor and Editors & Viewers - Text Editor to change how the editor behaves.
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Figure 22. The Edit menu.

¥ Editor X %

(@ ExampleFuncpy x

&
=
4

Figure 23. Editing a Jython script. The line with the cursor is highlighted. The arrow shows the next line

to be executed.

print 1
pirivit: 2

Y ou can run scripts with the following four icons:

E= Run: runs either asingle line of your script (the one indicated by the arrow) or all the selected

lines at once.

b Run all: runs the entire script.

This button also stops other activities within HIPE, like data analysis tasks. Note that if atask has
not been programmed to "listen” to the Sop button, pressing it will have no effect.

1P def funcid:

(] Sop: stops execution of the script. Note that the current line of the script will be completed
before the script stops running. This can lead to a delay before the script stops.

g
EE] Line by line: when pressed, this button is surrounded by a darker background. This causes a
change in the behaviour of the Run button, which is best shown by an example.
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Copy the script shown in Figure 23. Ensure that the Line by line button is not pressed. Select the
twolinessayingprint 1andprint 2 andpresstheRun button. Youwill get an error message.
Thisis dueto the fact that these two lines are within a code block (afunction in this case). You are
trying to execute only part of the block, which confusestheinterpreter. If you pressthe Line by line
button and try again, the code will run with no errors.

The Editor view is used for much more than editing script. For example, it can show detailed infor-
mation about data products (see Figure 24) and is where the graphical interface of data analysistasks
is shown (see Figure 25 for atypical example).

] Editor % (=8
5 | & myimage2 x g rotateTask ( UM_examples_checkspy '\ ® rotateTask (s resutt (5 < b =

heta Data

name value ~ unit description

type Unknman Praduct Type ldentification

creator Unknown Generator of this product

creationDate |2003-05-29T11:49:147 Creation date of this product

description  |Unknown Mame of this product

instrument  [Unknown Instrument attached ta this product

maodelMame  [Unknown hodel name attached to this product

startDate 2008-05-29T11:49:147 Stant date of this product

endCate 2008-05-29T11:49:147 End date of this product

naxis 2 WS Number of Axes

crpixl 248.0 WCS: Reference pixel position axis 1, unit=Scalar

crpix? 29.0 WCS: Reference pixel position axis 2, unit=Scalar

chvall 30.0 WCS: First coardinate of reference pixel

cryal2 -22.5 WCS: Second coordinate of reference pixel =

=y i ul Thao mauebor of Lt

Figure 24. A window shows metadata associated with an image within the Editor view.

17| /] Editar % *,

{2 imageSubtract x\

=

Inputs

Minuend n a
Subtrahend |Image - | 4]
Reference |Wcs - |

= Dytputs
Variable name for difference: |difference | %
A
of

M Arcept
(== [Bo

[ History &, Log | & Console x

Figure 25. Window showing a task interface within the Editor view.

3.3.4. Export Herschel Data from HIPE

This view allows Herschel data to be exported from the session into a directory structure which is
identical to the one found in the tar file of observations received from the Herschel Science Archive.

3.3.5. Herschel Science Archive

In this view you can log into the Herschel Science Archive (HSA) and open its graphical interface.
See the Data Analysis Guide for more information.
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Z! Herschel Science Archive X [ i
rLog in
Mot logged in
Passward:

rACcess

| Qpen HSA User Interface |

Figure 26. The Herschel Science Archive interface view.

3.3.6. HIFI pipeline

ThisviewreactstoHi fi Ti nel i nePr oduct objectsonly. SelectingaHi fi Ti el i nePr oduct
will show the tasks that can be used on that object.

3.3.7. History

The History view provides a list of the commands executed at the console and from Jython scripts.
This also shows whether the command was successful or not. Pay attention to these icons:

El The command was successful.
ﬁ The command caused an error.

* Thisicon appears next to a failed command, and indicates that the row can be expanded to
reveal additional information. In particular, the Trace column will show adetailed traceback of the

error (see Figure 27).

(2] Tapio Help | ] History x | 1og 5] consale (=B
Line | Status Command Etror Trace

5 a8 = |resultl = rotateTask jawva.lang. I1]legesEtdl

Figure 27. Traceback of an error from the History view.

Y ou can a'so copy the commands to the clipboard and save them to file. Thisis useful if you want to
re-run the commands later as a script. To copy or save the command history, follow these steps:

1. Click on the header of the Command column to select the entire column. Alternatively, click and
drag the mouse pointer within the column to select only afew cells.

2. Right click anywherein the table. A context menu appears, with the Copy and Save options.
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* If you choose Copy, you can then paste the information in a script within the Editor view.
* If you choose Save, a standard dialogue window for saving to file appears.

Information in the Error and Trace columns can be copied and saved in the same way.

3.3.8. Import Herschel data to HIPE

With this view you can import Herschel data into a HIPE session from the tar file of observations
retrieved from the Herschel Science Archive.

3.3.9. Log

3.3.10.

3.3.11.

Thisview lists al the commands that have been executed, like the History view, but also any output
and warning generated by the system. Y ou can filter messages according to their severity level: click
the arrow at the upper right corner of the view to reveal the menu shown in Figure 28.

Log > [l console =0
B B >

04 Moy 2008 13:55:02.5831 INFO: [Cammand] hifiFipeline.obs
04 Moy 2008 13:587:02.5815 INFO: [Cammand] print ohs1.get
04 Moy 2008 135720062 INFO: [Cammand] print ohs1 fram

@ Filter level FINE

04 Mov 2008 13:57:38.593 INFO: [Command] print obs1 from Filter level INFO
Filter level WWARNING
Filter level SEVERE

Figure 28. Filtering messagesin the Log view.

Navigator

The Navigator view provides access to the files and directories on your disk. Right-click on any item
to display a context menu with the available actions (see for instance Figure 29). Double-click on an
item to open it in HIPE with the default tool.

dataset_demao. py

B Mew...
Open Entar
| Open with

¥ Delete Delete

= Run script
B+ Run in background

imageExamplel. oy
imageExample2 oy

BTEEEELLELNE

Figure 29. The Navigator view showing the options available for a Jython script.
Outline

Thisview displaysinformation about the sel ected variablein the Variablesview (see Section 3.3.18). If
more than one variableis selected, information is displayed about the first selected variable. Common
information displayed is the variable name, type (class) and package in which the variable type is
defined (see for instance Figure 30).

Note that you cannot edit the contents of this view.
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Figure 30. Outline of avariablein the Outline view.

3.3.12. PAL Storage Manager

In this view you can manage pools and storages, which you can use to store, query and retrieve your
Herschel data. For more information see the Data Analysis Guide.

Note that this view is deprecated. Equivalent functionality will become available in the HIPE Prefer-
ences window.

3.3.13. Packages

This view shows the packages available to the session and the classes within each package. (see Fig-
ure 31). When you click on an item, some additional information is displayed in the Outline view.

Packages and classes are advanced concepts you will only need if you want to develop Jython scripts.
For more information, see the Scripting and Data Mining guide.

£ Packages x [ =8
— 3] AuisMarker -
~ [J] ComboPlot

= m CubeSpectrumanalysisToolbox
~ [J] CustomizedAnnotation

~ [1] Display

— 1] Irmagesxis

— 1] Layerxr

— [1] Plovoy

— [1] PreviewFactory

~ [J] Rectannotation

= m SpectrumComponentFactory
- [J] styte

— [J] SubPlot

— [J] symbolshape

~ [J] TaskToolRegistry

- apps

- cube

- explarer
-image
- kernel

E—- B E—F—

Figure 31. The Package view.

3.3.14. Product Browser

This view is the main component of the Product Browser perspective (see Section 3.1.1). It allows
you to query and browse products stored locally or remotely.
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For more information see the Data Analysis Guide: Section 1.3.7.

3.3.15. Product Tree

Like the Product Browser view, thisview is also part of the Product Browser perspective.

When you select a product in the Variables view, the Product Tree view gives you additional infor-
mation.

5= Product Tree X -0
MapContext for SPIRE products

harne walue uhit description | ‘
e SpireMapCantext Product Type ldentification -
creator [SPCw2.1.0 Cenerator of this product
creatio... [2010-02-10T... Creation date of this product
descri MapContext for Mame of this product
linstru... |SPIRE lInstrument attached to this procuct
model... |Unknown Model name attached to this prod...
startDate|2003-11-30T Stan date of this product
endDate |2003-11-30T End date of this product |
r

x
C herschel spire.ja.dataset. o :urn:hsa:hersc. ..outputDataset
P IPP - herschel.spire.ia.d

D Datasets (223
o History - herschel.i

outputDataset - he

Figure 32. The Product Treeview.

The top pane shows the metadata associated with the product. The lower |eft pane shows atree struc-
ture of all theinner products and datasets contained in the product. Thisisespecially useful for explor-
ing entire observations, which have an "onion" structure made of several layers. The lower right pane
shows the unique identifier for any product selected in the lower left pane. Thisidentifier is useful if

you want to manage the product via the command line. Click the icon to the right of the identifier to
copy the string to the clipboard.

3.3.16. Save Products to Pool

In this view you can save data (Herschel data products) from your session into a pool. See the Data
Analysis Guide for examples: Section 1.3.9.

3.3.17. Tasks

Thisview lists all the tasks (pipeline steps, data analysis routines and other tools) available in HIPE.
The tasks are listed under three folders, which you can open and close with adouble click:

« All: listsall the available tasks.

» Applicable: thisfolder is populated only when you select a variable in the Variables view. In this
casg, it lists al the tasks that can be applied to that variable.

» By category: this folder has four subfolders (General, Hifi, Pacs and Spire) listing general tasks
and tasks relevant to a specific instrument.

Double click on atask to open its dialogue window in the Editor view (see Figure 25 for an example).
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3.3.18.

Tasks X %

= 4|

== Applicable

t annularskyhperiurePhotometrny
autarnaticContaur
hoxCarsmoothing
circleHistogram

clamp
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createfghlimange

crop
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Figure 33. Tasks view with the tasks applicable to an image.
Right-click on atask to display a context menu with the following entries:
» Open and Open With: opens the dialogue window of the task.

» View source: displaysthe source code of thetask. Thisisuseful if you want to inspect the algorithm
used or if you plan to modify the task. Note that, for this entry to work, you must have selected the
option to include the source code when you installed HIPE.

» Help in URM: opens the help page for the task in the User Reference Manual. This entry is not
available for al tasks.

Variables

Thisview shows the variables available in your session. Select avariable to obtain more information
in the Outline view (see Section 3.3.11). Double click on a variable to display its contents with the
default tool. Right click on avariable to display a context menu with the following options:

» Open: displays the contents of the variable with the default tool.

» Open With: displays a submenu with alist of tools that can be used to display the contents of the
variable.

» Send to: displays a submenu with entries to save the variable to FITS file or to alocal store (see
the Data Analysis Guide for more information on local stores).

» Show methods: displaysin the Console view all the methods (routines) applicable to the variable.
This is useful if you are working on a script or issuing command-line instructions involving the
variable.

» Renameand Delete: self-explanatory.

* Help in URM: displays the help page about the variable type from the User Reference Manual.
This option may not be available for al variables.

» Helpin DRM: displaysthe help page about the variabletypefrom the Devel oper Reference Manual,
aso known as APl Documentation or Javadoc. This option may not be available for all variables.
Note that the DRM contains advanced, devel oper-oriented information. See the Scripting and Data
Mining guide for information on how to use the DRM.
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22 variables x

@ @ Nofiltered
@ animage

Filter Product
Filter Dataset

Filter Mumeric

Figure 34. Variables view with filtering menu.

Click the cross below the view title to delete all variables. Click the arrow at the upper right corner of
the view to display a menu to filter variables according to their type (see Figure 34).

3.3.19. Welcome

Thisistheinitial Welcome window (see Figure 7).

3.4. Viewers in HIPE

A convenient feature of HIPE isthat recognises the type of variables held in asession (whether itisa
dataset, a spectrum, an image, a cube, a scalar constant and so on). Items appearing in the Variables
or Outline views, with a green dot to their left, can potentially be opened. See Section 3.3.18 for how
to display the contents of a variable with the default tool or with another available tool.

An example is shown for aSi npl el mage. A right-click on avariable of thistype in the Variables
view shows there are three viewers (see Figure 35). The Product Viewer shows associated metadata
and array values; the Wcs explorer shows WCS settings; the Standard Image Viewer displays the
image.

[[l][e anarray
Ll animage

Product Viewer
wics explorer for Images
Standard Image Yiewer

Show methodls
Rename
¥ Delete Delete

E= Outling —
(@) Help ih URM  F1
name (Z) Help in DRM
class

RS

Figure 35. Available viewers are shown with a right-click.

4. IDL to HIPE/Jython command mapping

The following tables contain the HIPE/Jython equivalents of the most common IDL commands and
functions.

Table 4. Basic commands

Command IDL HIPE/Jython equivalent
Create avariable a=5 a=5

Get info on avariable type help,a printa__class

Print value of variable print, a print a

Create an array a=[2,3] a=Floatld([2., 3.])
Create alist - a=[2,3]

Create an automatic array a=findgen(10) a=Float1d.range(10)

Get info on array variable print, a print a
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Command IDL HIPE/Jython equivalent
Get one element of array print,a(1) print a[1]

Define new 1D array of 10 ele-|a= fltarr(10) a= Float1d(10)

ments

Assign value inside an array a(4)=219 a4] =219

Define new 2D array of 10,5 €l-
ements

a=fltarr(10,5)

a= Float2d(10, 5)

First element index number 0 0
Table 5. Plotting
Command IDL HIPE/Jython equivalent

Open a plotting window

window,retain=2

p=PlotXY ()

Plot two numeric arraysa & b

plot,ab

p=PlotXY (a,b)

Define axis ranges and styles

plot,a,b,[xy]range=[0.,10.],
[xy]title="lambda"

PlotXY (a,b,[xy]range=[0.,10.],
[xy]title="$\lambda$")

Defineline style

plot,a,b,linestyle=1

p.style.line=2 (later)

Define plotting symbol

plot,a,b,psym=2

p.style.symbol=5 (later)

Define plot title

plot,abtitle="title

PlotXY (ab,title='title)

device filename="file.ps"

Overplot oplot,ac p[1]=LayerXY (ac)

Make Annotations xyouts,0.2,0.7,Label' d.addAnnotation("Label", 0.2,
0.7)

Make postscript hardcopy set_plot,'ps p.saveAsEPS("file.ps")

device,/close
set_plot,'X'
Make a JPG hardcopy - p.saveAsIPG("filejpg")
Make a PNG hardcopy - p.saveAsPNG("file.png")
Make a PDF hardcopy - p.saveAsPDF("file.pdf")
Further customisations - (right-click on plot and select
Properties)
Table 6. Importing/exporting data
Command IDL HIPE/Jython equivalent

Reading an ascii table

readcol ,'file.dat',a,b,c

t = simpleAscii TableReader(file
= "file.dat")

(.csv) ascii table

DELIMITER=',

Plot read data plot,ab p=PlotXY (t["c0"].getData(),
t["c1"].getData())
or right-click on t and choose
Open with TablePlotter

Read a Comma Separated Table|readcol, file.csv', t = asciiTableReader(file =

"file.csv")

Read aimage FITSfile

im=mrdfits("imagefits")

im = fitsReader(file
"image.fits")
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Command

IDL

HIPE/Jython equivalent

Display image

tvedl,im

right-click on "im" and Open
with "ImageViewer"

Read acube FITSfile

cube=mrdfits("cube.fits")

im =
"cubefits")

fitsReader(file =

Display cube

right-click on "cube" and Open
with "CubeAnalysisT ool box"

Read a spectrum FITSfile

sp=mrdfits("spec.fits")

sp = fitsReader(file = "spec.fits")

Display spectrum plot,wave,flux right-click on "sp" and Open
with " SpectrumExplorer"
Writingto FITS mwrfits,image,'image.fits simpleFitsWriter(product = im-

age, file = "imagefits")

Writing an ascii table (csv by de-
fault)

get_lunu

openw, u, file.csv'

ascii TableWriter(table=1t, file =
"file.csv")

printf,u,ab
close,u
free lun,u
Table7. Arithmetic
Command IDL HIPE/Jython equivalent
Adding 3+4 3+4
Multiply 3.* 4. 3.* 4.
Powers 34 3**4
Absolute abs() absolute(), fabs()
Arc cosine acos() arccos()
Natural logarithm aog() log()
10th base logarithm aogl0() 10g10()
Arcsine asin() arcsin()
Arc tangent atan() arctan()
Cell cel() cel()
Conjugate conj() conjutage()
Cosine cos() cos()
Hyperbolic cosine cosh() cosh()
Exponential exp() exp()
Floor floor() floor()
Invert (matrix) invert() Matrix (module)
Bit shift operations ishft() right_shift(),left_shift()
Sine sin() sin()
Hyperbolic sine sinh() sinh()
Square root sart() sart()
Tangent tan() tan()
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Command IDL HIPE/Jython equivalent
Hyperbolic tangent tanh() tanh()

Random O-1 generator randomu() random()

Reverse array 'a reverse(a) a::-1]

Collapse of array total(a) sum(a)

Number of elements n_elements() len(), size()

Number of parameters n_params() len(*args)

Extra parameters _extra **kwargs

Size size() shape(),arrayvar.type()
Pause time wait time.sleep()

Execute script execute() exec()

Thse are external resources that you may find useful:

« IDL to Python
 Jython homepage

» Python for astronomers

Note that HIPE is based on Jython 2.1, while the latest Jython version is 2.5. Therefore, examples

from these external sites might not always work.
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